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IBM Rational Developer for System z Version 7.6 release
notes

The following release notes provide information about new features and
enhancements included in Rational® Developer for System z® Version 7.6 and lists
the known limitations in the release.

This information is for developers using Rational Developer for System z Version
7.6.

Hardware Requirements

For hardware and software requirements, see the following documents:
v z/OS® host requirements: Rational Developer for System z Host Configuration

Guide
v AIX® and Linux® requirements: Rational Developer for System z RSE Server

Installation Guide: AIX and Linux
v Linux on System z requirements: Rational Developer for System z RSE Server

Installation Guide: Linux on System z
v Client requirements: Rational Developer for System z Installation Guide

Installation and Configuration

For information on installing and configuring Rational Developer for System z, see
the following documents:
v z/OS host installation: Program Directory for Rational Developer for System z
v z/OS host configuration: Rational Developer for System z Host Configuration

Quick Start Guide
v z/OS host configuration: Rational Developer for System z Host Configuration

Guide
v AIX and Linux installation: Rational Developer for System z RSE Server

Installation Guide: AIX and Linux
v Linux on System z installation: Rational Developer for System z RSE Server

Installation Guide: Linux on System z
v Client installation: Rational Developer for System z Installation Guide

Features and Limitations

For information on new features and limitations in the Rational Developer for
System z, see the following summary:

z/OS Integrated Development Environment

v “CICS 4.1 support for Content Assist” on page 6
v “Content assist for commands in the LPEX command line” on page 6
v “Enhanced support for non-round-trip characters” on page 7
v “Obtain up-to-date output for active jobs” on page 7
v “Performance enhancements on file transfer and content assist” on page 7
v “Remote Resource Access API” on page 7
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v “PL/I enhanced editing support” on page 7
v “Property Group editor” on page 7
v “Support for multiple local preprocessors” on page 7
v “IBM Rational Developer for System z Version 7.6 - IBM Rational Team Concert

for System z Version 2.0 Integration” on page 7
v “Limitation: PL/I syntax is incorrectly marked with warnings” on page 7
v “Limitation: Getting the active job output is not supported for JES3 releases

earlier than z/OS V1R10” on page 8

CA Endevor Software Change Manager Release 12

v “Interface for CA Endevor® Software Change Manager Release 12” on page 8

Service Component Architecture

v “Support for the Service Component Architecture” on page 8
v “Limitation: Editing the URI of the web service binding and saving the resource

does not update the WSDL file” on page 8

CICS®

v “Error messages that you can ignore” on page 9
v “Errors that do not cause a message” on page 16

COBOL for Windows®

v “Local syntax-checking support, and the level of Enterprise COBOL for z/OS”
on page 22

v “Object-oriented syntax, and Java 5 or Java 6 SDKs” on page 23
v “Runtime message traceback information” on page 23

Debug Tool for z/OS

v “Documentation updates for Debug Tool for z/OS Version 10” on page 25

PL/I Enhanced Editing

v “Limitation: Syntax checking incorrectly identifies errors” on page 24

File Manager Integration

v “File Manager Integration has renamed some of the views found within the
Formatted Data Editor” on page 25

v “Limitation: File Manager Integration requires File Manager Server Version 10.1”
on page 25

v “Limitation: Certain complex criteria created in the Build Criteria editor are not
supported” on page 25

v “Limitation: Data is lost when saving a dataset and the RSE connection is lost”
on page 25

v “Limitation: Creating templates with COBOL copybooks containing a COPY
command with a REPLACING clause” on page 26

v Limitation: When the network connection to the host is lost abnormally during
an edit session, the data set can be locked and cannot be opened again. Contact
your system administrator to release the data set.

MFS Editor

v “Copybook generation support for MFS files” on page 26
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C/C++ Language Support

v “Enhanced makefile editing support” on page 26
v “The Make with target action has been added to z/OS Unix subprojects and

files” on page 26
v “Predefined LPEX command support” on page 26
v “Macro support for assembly language” on page 27
v “F1 help support for assembly language” on page 27

Advanced COBOL Editor

v Enhanced content assist to include data items declared in EXEC SQL INCLUDE
statements (for example, SQLCA) and implicitly linked CICS data structures (for
example, DFHEIBLK).

v Improved support for the COBOL LPEX Editor IMS™ snippets have been
introduced to aid in the development of COBOL IMS applications.

v Enabled open declarations, hover help, and other features for data items
referenced in EXEC SQL and EXEC CICS statements.

v Added support for real-time syntax checking of CICS and SQL code embedded
in COBOL programs

v Enhanced the navigation in the COBOL LPEX Editor to use the F3 key and
hyperlinking

v Enhanced content assist to include information about variable declarations
v Limitation: The grammar used for parsing embedded SQL in COBOL programs

is not a complete DB2® for z/OS grammar and can show incorrect warning
annotations. Parsing embedded SQL using this limited grammar is optional and
can be enabled on the preferences page LPEX Editor>System z LPEX
Editor>COBOL Parser>COBOL Annotations and Tools.

v Limitation: Refactor operations are not atomic and cannot be undone.
v Limitation: The Open Perform Hierarchy operation will not be in sync if the

source file is modified or closed.

Application Deployment Manager

v Added functions to create an empty Application Deployment Manager manifest
in Eclipse projects and z/OS projects.

v Enhanced Application Deployment Manager to handle a subset of new functions
supported by CICS Explorer.

v Created a connection type for REST to let you use of both REST and SOAP
protocols CICS Resource Definition server connections.

v Limitation: Filtering resources within CICS Explorer views when connected to a
CICS Resource Definition server is limited to the name of the resource.

v “Limitation: Connections to a CICS Resource Definition server using the Web
services connection type do not support new CICS resource types” on page 28

v “Limitation: Only regions that host a CICS Resource Definition server are listed
in dialogs that generate code or CICS resources” on page 28

v “Limitation: Changing the password of an existing connection to a CICS
Resource Definition (CRD) server” on page 28

Software Configuration Library Manager (SCLM) Developer Toolkit

v “Limitation: ’SCLM Search’ and ’SCLM member security’ are not supported for
z/OS 1.8” on page 29
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Host Integration

v “A version of Perl must be installed to start the IBM Rational Developer for
System z Remote Systems Explorer (RSE) server.” on page 29

AIX, Linux, and Linux on System z

v “Update: AIX, Linux, and Linux on System z installation” on page 29
v “A version of Perl must be installed to start the IBM Rational Developer for

System z Remote Systems Explorer (RSE) server.” on page 29
v “Linux on System z host prerequisites” on page 30
v “Linux on System z RSE server prompts the user for twice to log in into the

system” on page 30
v “Limitation: Run Installation Manager as the root user” on page 31

Help Updates

v The following helps have been updated to reflect last minute changes:
– “Screen operation” on page 31
– “Implementation of Extract actions and Insert actions” on page 32

Web-based helps

v “Web-based help content” on page 32
– “Accessing Web-based help” on page 33
– “Downloading help content with the Local Help System Updater site” on

page 34
– “Installing help content locally using the Local Help Updater and the

RDz7.6_updateSite.zip file” on page 34
– “Updating help content” on page 35
– “Removing help content” on page 36
– “Setting up an intranet server for help content” on page 36
– “Changing the way that you access help content” on page 36

Enterprise Service Tools

v Single-service projects
– “XML TRANSFORM resources in the CICS TS 4.1 runtime” on page 38
– “Generating PL/I language data structures and runtime-specific XML

message processing” on page 38
– “Generating WSBind with the new WSBind parameters introduced in CICS

TS 4.1” on page 39
– “Mapping XML attributes to language structure members” on page 39
– “Creating MTOM/XOP-based Web service providers” on page 39
– “XML and Web Services batch processor: Specifying directory for input

language file location” on page 39
– “XML and Web Services batch processor: Specifying data names in mixed

case” on page 40
– “Compiled XML Conversion issues the message IRZ9999S” on page 40
– “Limitation: 01 level scalar element is not supported” on page 40
– “Limitation: PL/I Compiled XML Conversion does not honor the optional

″aligned″ or ″unaligned″ attributes” on page 40
– “Limitation: Meet-In-Middle import source files” on page 41
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– “Limitation: Bottom-Up conflict with old WSDL/XSD files and new WSDL
files and XSD files” on page 41

– “Limitation: COBOL conversion routines generated by single-service wizards
run in z/OS only” on page 41

– “Limitation: The Top-down and Meet-in-middle scenarios with importing
remote (z/OS UNIX) WSDL file which includes, imports, or redefines a
schema is not supported” on page 41

– “Limitation: XML Element nesting depth” on page 41
– “Limitation: OPT compiler option conflict” on page 41
– “Limitation: Case sensitivity of certain text entry fields in XML Enablement

wizards” on page 42
– “Limitation: Invalid pointers cause infinite loop” on page 42
– “Limitation: FILLER items in COBOL data structures” on page 42
– “Limitation: Automatic Match Mapping of COBOL groups containing

OCCURS DEPENDING ON items” on page 42
– “Limitation: Generate>XML File menu item does not honor XSD schema

restrictions” on page 42
– “Limitation: XML and Web Services batch processor: Invalid entries in

configuration XML may cause null pointer exceptions during the batch
process” on page 42

– “Limitation: Restriction on figurative constants LOW-VALUES and
HIGH-VALUES” on page 43

– “Limitation: GB18030 characters in an Enterprise Service Tools single-service
project name” on page 43

– “Limitation: Temporary files not always cleaned up” on page 43
– “Limitation: Temporary project not always cleaned up” on page 43
– “Limitation: When migrating version 6.0 mapping files (.cmx files) source files

referenced by the .cmx file must be in the same folder” on page 43
– “Limitation: Support for DBCS data members with SOAP for CICS and Web

Services for CICS” on page 43
– “Limitation: DBCS characters are not allowed in the name of the generated

XML converter files” on page 44
– “Limitation: Global element names in generated XML schemas are not

consistent between Interpretive and Compiled XML conversion types” on
page 44

– “Limitation: Enterprise COBOL issues message IGYOP3094 when compiling
COBOL XML Converters using the OPTIMIZE (OPT) option.” on page 44

v Service flow projects
– “Expanded runtime support for CICS Transaction Server for z/OS” on page

45
– “Improvements for Extract actions, Insert Actions, and loop variables” on

page 45
– “Limitation: A Web service generated from a service flow project cannot call

itself (recursive call)” on page 45
– “Limitation: A limitation on a flow with a connection wired back onto itself”

on page 45
– “Limitation: Importing a COBOL copy book file fails when the path or file

name contains non-English characters” on page 45
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– “Limitation: Conflicting message and field names cause compile error” on
page 46

– “Limitation: A limitation on imported source code with a usage clause of
POINTER” on page 46

– “Limitation: Screen messages are not easily replaced” on page 46
– “Limitation: Importing a COBOL program for use as a LINK with Channel

node and opening the operation in the operations editor prevents modifying
the generation properties” on page 46

– “Limitation: Flow plays back incorrectly if it contains a while loop that exits
from a node other than the last node” on page 46

Hardware Requirements
For hardware and software requirements, see the following documents:
v z/OS Host Requirements: Rational Developer for System z Host Configuration

Guide
v AIX and Linux Requirements: Rational Developer for System z RSE Server

Installation Guide: AIX and Linux
v AIX and Linux Requirements: Rational Developer for System z RSE Server

Installation Guide: Linux on System z
v Client Requirements: Rational Developer for System z Installation Guide

Installation and configuration
For information on installing and configuring Rational Developer for System z, see
the following documents:
v z/OS host installation: Program Directory for Rational Developer for System z
v z/OS host configuration: Rational Developer for System z Host Configuration

Quick Start GuideGuide
v z/OS host configuration: Rational Developer for System z Host Configuration

Guide
v AIX and Linux installation: Rational Developer for System z RSE Server

Installation Guide: AIX and Linux
v Linux on System z installation: Rational Developer for System z RSE Server

Installation Guide: Linux on System z
v Client installation: Rational Developer for System z Installation Guide

z/OS Integrated Development Environment

CICS 4.1 support for Content Assist
CICS 4.1 support for Content Assist provides syntax completion in an edit session
for COBOL and PL/I programs using CICS Transaction Server for z/OS 4.1 on the
host.

Content assist for commands in the LPEX command line
Content assist for commands in the LPEX command line now provides the ability
to invoke LPEX commands easily. Users can invoke content assist (CTRL + Space)
on the LPEX command line to quickly and easily get to the LPEX commands.
System z LPEX command-line content assist displays Developer for System z
developed user commands and base LPEX commands (plus ISPF primary
commands when the ISPF mode is in effect).
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Enhanced support for non-round-trip characters
The Enhanced support for non-round-trip characters identifies the location of
characters which cannot be transferred correctly between the remote and local
character sets.

Obtain up-to-date output for active jobs
The JES Subsystem displays the most current job output, even output that is in
active buffers and has not yet been written to SPOOL. This up-to-date output
applies to both JES2 and JES3.

Performance enhancements on file transfer and content assist
Performance improvements have been made in the areas of file download, file
upload, opening of files in the editor, and fetching copybook/include files during
the content assist operation.

Remote Resource Access API
The Remote Resource Access API component of IBM® Rational Developer for
System z provides a formal API for customers and third party vendors to extend
the functionality of the product by programmatically accessing and manipulating
remote resources.

PL/I enhanced editing support
PL/I Enhanced Editing Support provides real-time syntax checking for PL/I
programs, like the real-time syntax checking for COBOL programs.

Property Group editor
The Property Group editor provides an Eclipse editor for editing and creating
property groups as well as editing property group overrides. The editor provides
validation and assistance to users when specifying properties with data set names
as values.

Support for multiple local preprocessors
Support for multiple local preprocessors provides a way for users to call multiple
local preprocessors before a COBOL or PL/I compilation for syntax checking and
build.

IBM Rational Developer for System z Version 7.6 - IBM
Rational Team Concert for System z Version 2.0 Integration

IBM Rational Team Concert for System z Version 2.0 and IBM Rational Developer
for System z Version 7.6 not only provide shell sharing but also a more powerful
integration to enable clients to take advantage of the IDE capabilities and team
based development features for the z based artifacts.

Limitation: PL/I syntax is incorrectly marked with warnings
Problem: There are many situations where legitimate PL/I syntax is incorrectly
marked with warnings by the real-time syntax checking feature..

Workaround: To turn off the real-time syntax checking, open the preferences
(Windows --> Preferences>LPEX Editor>System z LPEX Editor>PL/I Parser>PL/I
Annotations and click Disable editor annotations.
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Limitation: Getting the active job output is not supported for
JES3 releases earlier than z/OS V1R10

Problem: For obtaining up-to-date output for active jobs, getting the active job
output is not supported for JES3 releases earlier than z/OS V1R10. This limitation
is caused by JES API limitations in the earlier releases.

Workaround: Use JES3 release z/OS V1R10 or later.

Interface for CA Endevor Software Change Manager

Interface for CA Endevor® Software Change Manager Release
12

The IBM Rational Developer for System z interface for CA Endevor® Software
Change Manager Release 12 RAM (Repository Access Manager) allows you to
access and edit software assets stored in CA Endevor® SCM projects. RAMs are
used by a CARMA server (common access repository manager), which is part of
Developer for System z. If the CARMA RAM is available and configured on your
host system, then you can connect to a CA Endevor® SCM project using the
CARMA plug-in of the Rational Developer for System z client.

Service Component Architecture

Support for the Service Component Architecture
Support for the Service Component Architecture (SCA) is new in this release.
Developer for System z Service Component Architecture development tools for
CICS is a powerful, integrated extension to Developer for System z for the
assembly of service-oriented application components based on the open Service
Component Architecture and the deployment of SCA assets to CICS Transaction
Server for z/OS 4.1. For more information see “Developing Service Component
Architecture (SCA) applications”

Developing Service Component Architecture (SCA)
applications

SCA Development Tools is a powerful, integrated extension to IBM Rational
Developer for System z for the assembly of service-oriented application
components based on the open Service Component Architecture and the
deployment of SCA assets to CICS Transaction Server for z/OS 4.1.

For information about SCA and Open Service Oriented Architecture (OSOA), see
the “Related information” section at the end of this topic.

SCA Development Tools includes a concise set of tools for developing SCA service
components implemented with CICS application programs, for graphically wiring
components together to form new composite services, for associating protocol
bindings to SCA components, and for packaging up SCA assets and deploying
them to CICS Transaction Server for z/OS.

Limitation: Editing the URI of the web service binding and
saving the resource does not update the WSDL file

After deploying an SCA Composite as a CICS bundle, editing the URI of the web
service binding and saving the resource does not update the WSDL file used for
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the promoted service. If the composite is redeployed after saving the modified
URI, the web service will not work using the unmodified WSDL.

CICS

Error messages that you can ignore
Some of the keywords associated with CICS command have changed over the
years, but have been retained for compatibility reasons. A few of these obsolete
keywords are incorrectly flagged as invalid by the syntax checker. These are listed
in Table 1, together with an explanation of the problem, and the action that you
should take if you encounter it.

Table 1. Keywords incorrectly flagged as invalid by the syntax checker

Command Description Acrion

ALLOCATE The NOSUSPEND keyword is an
alternative to the NOQUEUE keyword
for this command.

If you specify NOSUSPEND, the syntax
checker returns: Invalid command
option 'NOSUSPEND'

You can ignore this error
because the syntax is
correct.

ASSIGN The OPSECURITY and OPERKEYS
keywords are supported for
compatibility reasons.

If you specify either of these keywords,
the syntax checker returns: Invalid
command option 'OPSECURITY'Invalid
command option 'OPERKEYS

You can ignore these errors
because the syntax is
correct.

CSD
GETNEXTRSRCE

If using a resource name (For example:
PROGRAM) instead of the RESTYPE
keyword the syntax checker will return:
Invalid command option 'PROGRAM'.

You can ignore this error
because the syntax is
correct

DELETE You can use the keyword DATASET as
an alternative to FILE for this command.
(This is for compatibility with earlier
releases, and is not documented.)

If you do this, the syntax checker
returns: Invalid command option
'DATASET'

This might cause other options to be
flagged as invalid.

You can ignore this error
because DATASET is
accepted as an alternative
to FILE.

If this problem has caused
other options to be flagged
as invalid, you might want
to change DATASET to
FILE to check that there are
no other errors.
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Table 1. Keywords incorrectly flagged as invalid by the syntax checker (continued)

Command Description Acrion

DELETEQ TS The keyword TS is optional for this
command. (This is for compatibility
with earlier releases, and is not
documented.)

If you do not specify the TS option, the
syntax checker assumes that the
command is DELETEQ TD, and returns:
Command is ambiguous, 'TD' has been
assumed

This causes other options to be flagged
as invalid.

You can ignore this error
because the syntax is
correct.

However, if you want to
check the other options that
were flagged as invalid you
must specify TS to check
that there are no other
errors.

DEQ A CVDA value of LUW is supported as
an alternative to UOW for compatibility
reasons.

If you specify LUW, the syntax checker
returns: Invalid command option 'LUW

You can ignore this error
because the syntax is
correct.

DOCUMENT
RETRIEVE

The CLNTCODEPAGE keyword is an
alternative to the CHARACTERSET
keyword for this command.

If you specify CLNTCODEPAGE, the
syntax checker returns: Invalid command
option 'CLNTCODEPAGE'

You can ignore this error
because the syntax is
correct.

ENDBR You can use the keyword DATASET as
an alternative to FILE for this command.
(This is for compatibility with earlier
releases, and is not documented.)

If you do this, the syntax checker
returns: Invalid command option
'DATASET'

This might cause other options to be
flagged as invalid.

You can ignore this error
because DATASET is
accepted as an alternative
to FILE.

If this problem has caused
other options to be flagged
as invalid, you might want
to change DATASET to
FILE to check that there are
no other errors.

ENQ A CVDA value of LUW is supported as
an alternative to UOW for compatibility
reasons.

If you specify LUW, the syntax checker
returns: Invalid command option 'LUW

You can ignore this error
because the syntax is
correct.

INQUIRE
DSNAME

The BKOUTSTATUS option is obsolete
on this command, but has been retained
for compatibility with earlier releases.

If you specify BKOUTSTATUS, the
syntax checker returns: Invalid command
option 'BKOUTSTATUS'

You can ignore this error
because the syntax is
correct.

However, CICS will accept
the keyword and issue an
informational message
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Table 1. Keywords incorrectly flagged as invalid by the syntax checker (continued)

Command Description Acrion

INQUIRE
JOURNALNUM

This command is obsolete and is
retained only for compatibility reasons.

If you specify this command, the syntax
checker returns: Invalid command
option 'JOURNALNUM'

This might cause other options to be
flagged as invalid.

You can ignore these errors
because the syntax is
correct.

However, CICS will accept
the command and issue an
informational message

INQUIRE
NETNAME

The SCREENWIDTH and
SCREENHEIGHT keywords have been
replaced by SCRNHT and SCRNWD on
this command, but are supported for
compatibility reasons.

If you specify either of these keywords,
the syntax checker returns: Invalid
command option 'SCREENWIDTH'Invalid
command option 'SCREENHEIGHT'

You can ignore these errors
because the syntax is
correct.

INQUIRE
PROGRAM

The JVMDEBUG option is obsolete on
this command, but has been retained for
compatibility with earlier releases.

If you specify JVMDEBUG, the syntax
checker returns: Invalid command
option 'JVMDEBUG'

You can ignore this error
because the syntax is
correct.

CICS returns NODEBUG as
the CVDA value.

INQUIRE TASK The DTB option is obsolete and was
replaced by INDOUBT on this
command. However, it has been
retained for compatibility with earlier
releases.

If you specify DTB, the syntax checker
returns: Invalid command option 'DTB'

You can ignore this error
because the syntax is
correct.

CICS returns
NOTSUPPORTED as the
CVDA value.

INQUIRE
TERMINAL

The SCREENWIDTH and
SCREENHEIGHT keywords have been
replaced by SCRNHT and SCRNWD on
this command, but are supported for
compatibility reasons.

If you specify either of these keywords,
the syntax checker returns: Invalid
command option 'SCREENWIDTH'Invalid
command option 'SCREENHEIGHT'

You can ignore these errors
because the syntax is
correct.
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Table 1. Keywords incorrectly flagged as invalid by the syntax checker (continued)

Command Description Acrion

INQUIRE
VOLUME

This command is obsolete and is
retained only for compatibility reasons.

If you specify this command, the syntax
checker returns: Invalid command
option 'VOLUME'

This might cause other options to be
flagged as invalid.

You can ignore these errors
because the syntax is
correct.

However, CICS will accept
the command and issue an
informational message

READ You can use the keyword DATASET as
an alternative to FILE for this command.
(This is for compatibility with earlier
releases, and is not documented.)

If you do this, the syntax checker
returns: Invalid command option
'DATASET'

This might cause other options to be
flagged as invalid.

You can ignore this error
because DATASET is
accepted as an alternative
to FILE.

If this problem has caused
other options to be flagged
as invalid, you might want
to change DATASET to
FILE to check that there are
no other errors.

READNEXT You can use the keyword DATASET as
an alternative to FILE for this command.
(This is for compatibility with earlier
releases, and is not documented.)

If you do this, the syntax checker
returns: Invalid command option
'DATASET'

This might cause other options to be
flagged as invalid.

You can ignore this error
because DATASET is
accepted as an alternative
to FILE.

If this problem has caused
other options to be flagged
as invalid, you might want
to change DATASET to
FILE to check that there are
no other errors.

READPREV You can use the keyword DATASET as
an alternative to FILE for this command.
(This is for compatibility with earlier
releases, and is not documented.)

If you do this, the syntax checker
returns: Invalid command option
'DATASET'

This might cause other options to be
flagged as invalid.

You can ignore this error
because DATASET is
accepted as an alternative
to FILE.

If this problem has caused
other options to be flagged
as invalid, you might want
to change DATASET to
FILE to check that there are
no other errors.
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Table 1. Keywords incorrectly flagged as invalid by the syntax checker (continued)

Command Description Acrion

READQ TS The keyword TS is optional for this
command. (This is for compatibility
with earlier releases, and is not
documented.)

If you do not specify the TS option, the
syntax checker assumes that the
command is READQ TD, and returns:
Command is ambiguous, 'TD' has been
assumed

This causes other options to be flagged
as invalid.

You can ignore this error
because the syntax is
correct.

However, if you want to
check the other options that
were flagged as invalid you
must specify TS to check
that there are no other
errors.

RESETBR You can use the keyword DATASET as
an alternative to FILE for this command.
(This is for compatibility with earlier
releases, and is not documented.)

If you do this, the syntax checker
returns: Invalid command option
'DATASET'

This might cause other options to be
flagged as invalid.

You can ignore this error
because DATASET is
accepted as an alternative
to FILE.

If this problem has caused
other options to be flagged
as invalid, you might want
to change DATASET to
FILE to check that there are
no other errors.

REWRITE You can use the keyword DATASET as
an alternative to FILE for this command.
(This is for compatibility with earlier
releases, and is not documented.)

If you do this, the syntax checker
returns: Invalid command option
'DATASET'

This might cause other options to be
flagged as invalid.

You can ignore this error
because DATASET is
accepted as an alternative
to FILE.

If this problem has caused
other options to be flagged
as invalid, you might want
to change DATASET to
FILE to check that there are
no other errors.

SET DSNAME The FAILEDBKOUT, NORMALBKOUT
and BKOUTSTATUS options are
obsolete on this command, but have
been retained for compatibility with
earlier releases.

If you specify any of these keywords,
the syntax checker returns: Invalid
command option 'FAILEDBKOUT'Invalid
command option 'NORMALBKOUT'Invalid
command option 'BKOUTSTATUS'

You can ignore these errors
because the syntax is
correct.

However, CICS will accept
the keywords and issue
informational messages
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Table 1. Keywords incorrectly flagged as invalid by the syntax checker (continued)

Command Description Acrion

SET
JOURNALNUM

This command is obsolete and is
retained only for compatibility reasons.

If you specify this command, the syntax
checker returns: Invalid command
option 'JOURNALNUM'

This might cause other options to be
flagged as invalid.

You can ignore these errors
because the syntax is
correct.

However, CICS will accept
the command and issue an
informational message

SET VOLUME This command is obsolete and is
retained only for compatibility reasons.

If you specify this command, the syntax
checker returns: Invalid command
option 'VOLUME'

This might cause other options to be
flagged as invalid.

You can ignore these errors
because the syntax is
correct.

However, CICS will accept
the command and issue an
informational message

STARTBR You can use the keyword DATASET as
an alternative to FILE for this command.
(This is for compatibility with earlier
releases, and is not documented.)

If you do this, the syntax checker
returns: Invalid command option
'DATASET'

This might cause other options to be
flagged as invalid.

You can ignore this error
because DATASET is
accepted as an alternative
to FILE.

If this problem has caused
other options to be flagged
as invalid, you might want
to change DATASET to
FILE to check that there are
no other errors.

UNLOCK You can use the keyword DATASET as
an alternative to FILE for this command.
(This is for compatibility with earlier
releases, and is not documented.)

If you do this, the syntax checker
returns: Invalid command option
'DATASET'

This might cause other options to be
flagged as invalid.

You can ignore this error
because DATASET is
accepted as an alternative
to FILE.

If this problem has caused
other options to be flagged
as invalid, you might want
to change DATASET to
FILE to check that there are
no other errors.

WEB READ The CLNTCODEPAGE keyword is an
alternative to the CHARACTERSET
keyword for this command.

If you specify CLNTCODEPAGE, the
syntax checker returns: Invalid command
option 'CLNTCODEPAGE'

You can ignore this error
because the syntax is
correct.
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Table 1. Keywords incorrectly flagged as invalid by the syntax checker (continued)

Command Description Acrion

WEB RECEIVE The CLNTCODEPAGE keyword is an
alternative to the CHARACTERSET
keyword for this command.

If you specify CLNTCODEPAGE, the
syntax checker returns: Invalid command
option 'CLNTCODEPAGE'

You can ignore this error
because the syntax is
correct.

WEB SEND The CLNTCODEPAGE keyword is an
alternative to the CHARACTERSET
keyword for this command.

If you specify CLNTCODEPAGE, the
syntax checker returns: Invalid command
option 'CLNTCODEPAGE'

You can ignore this error
because the syntax is
correct.

WEB
STARTBROWSE

The CLNTCODEPAGE keyword is an
alternative to the CHARACTERSET
keyword for this command.

If you specify CLNTCODEPAGE, the
syntax checker returns: Invalid command
option 'CLNTCODEPAGE'

You can ignore this error
because the syntax is
correct.

WRITE You can use the keyword DATASET as
an alternative to FILE for this command.
(This is for compatibility with earlier
releases, and is not documented.)

If you do this, the syntax checker
returns: Invalid command option
'DATASET'

This might cause other options to be
flagged as invalid.

You can ignore this error
because DATASET is
accepted as an alternative
to FILE.

If this problem has caused
other options to be flagged
as invalid, you might want
to change DATASET to
FILE to check that there are
no other errors.

WRITEQ TS The keyword TS is optional for this
command. (This is for compatibility
with earlier releases, and is not
documented.)

If you do not specify the TS option, the
syntax checker assumes that the
command is WRITEQ TD, and returns:
Command is ambiguous, 'TD' has been
assumed

This causes other options to be flagged
as invalid.

You can ignore this error
because the syntax is
correct.

However, if you want to
check the other options that
were flagged as invalid you
must specify TS to check
that there are no other
errors.

WEB ENDBROWSE If using the HTTPHEADER keyword
the SESSTOKEN keyword is optional,
however if you omit it then the syntax
check returns: Command requires the
option '<Expression>'

You can ignore this error
because the syntax is
correct.
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Table 1. Keywords incorrectly flagged as invalid by the syntax checker (continued)

Command Description Acrion

WEB READ If using the HTTPHEADER keyword
the SESSTOKEN keyword is optional,
however if you omit it then the syntax
check returns: Command requires the
option '<Expression>'

You can ignore this error
because the syntax is
correct.

WEB
STARTBROWSE

If using the HTTPHEADER keyword
the SESSTOKEN keyword is optional,
however if you omit it then the syntax
check returns: Command requires the
option '<Expression>'

You can ignore this error
because the syntax is
correct.

Errors that do not cause a message
Some coding errors do not cause the syntax checker to issue a message. These
errors are listed in Table 1. If your program contains one of these errors, it will not
be flagged by the syntax checker, but it will be flagged when you translate the
program using the CICS translator.

Table 2. Errors that do not cause the syntax checker to issue a message

Command Error

All INQUIRE and FEPI
INQUIRE commands
that support browsing

You cannot use any other keywords if you use the START, AT®,
or END keywords to start or finish browsing.

You cannot provide a resource name if you use the START, AT,
or END keywords to start or finish browsing.

ALLOCATE You cannot use the PARTNER and PROFILE keywords together.

COLLECT STATISTICS If you specify the NODE keyword, you must also specify the
TARGET keyword.

CONNECT PROCESS You must specify either SESSION or PARTNER.

If you specify the PARTNER keyword, you must also specify
the CONVID keyword.

CONVERSE You cannot use the ATTACHID keyword with the CTLCHAR,
DEST, ERASE, DEFAULT, ALTERNATE, LDC, LINEADDR,
PSEUDOBIN, or STRFIELD keywords

You cannot use the FMH and LDC keywords together.

If you specify the SET keyword you must also specify either the
TOLENGTH or TOFLENGTH keyword.

CSD DELETE You must only specify one resource type keyword.

CSD GETNEXTGROUP You must specify the GROUP keyword.

CSD GETNEXTLIST You must specify the LIST keyword.

CSD GETNEXTRSRCE You must specify the RESTYPE, RESID and GROUP keywords.
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Table 2. Errors that do not cause the syntax checker to issue a message (continued)

Command Error

CSD INQUIREGROUP You must specify the GROUP keyword.

CSD INQUIRELIST You must specify the LIST keyword.

CSD INQUIRERSRCE You must only specify one resource name keyword.

DEFINE TIMER You cannot use the AT and DAYS keywords together.

You cannot use the AFTER keyword with the ON, YEAR,
MONTH, DAYOFMONTH, or DAYOFYEAR keywords.

DELETE CONTAINER You cannot use the CHANNEL keyword with the ACTIVITY,
ACQACTIVITY, PROCESS, or ACQPROCESS keywords.

DELETE FILE You cannot use the RBA, XRBA or RRN keywords with the
KEYLENGTH, GENERIC, or NUMREC keywords.

DISABLE PROGRAM You cannot use the EXIT keyword with the FORMATEDF,
PURGEABLE, SHUTDOWN, SPI or TASKSTART keywords.

ENABLE PROGRAM You cannot use the EXIT keyword with the FORMATEDF,
INDOUBTWAIT, LINKEDITMODE, OPENAPI, PURGEABLE,
QUASIRENT, SHUTDOWN, SPI, TALENGTH, TASKSTART, or
THREADSAFE keywords.

EXTRACT ATTACH You cannot use the SESSION or CONVID keywords with the
ATTACHID keyword.

EXTRACT WEB You cannot use the SESSTOKEN keyword with the
REQUESTTYPE keyword.

EXTRACT TCPIP No errors are returned by the syntax checker for this command.

EXTRACT WEB If you use EXTRACT WEB for CICS as an HTTP server you
must not specify the SESSTOKEN keyword.

If you use EXTRACT WEB for CICS as an HTTP client you
must specify the SESSTOKEN keyword.

If you specify the HOST, HTTPVERSION, PATH,
PORTNUMBER, REALM or QUERYSTRING keywords, you
must specify their corresponding length keywords.

FEPI CONVERSE
DATASTREAM

You cannot use the CHAIN or RU keywords with the POOL
keyword.

You can use the POOL keyword only if you also use the
UNTILCDEB keyword.

FEPI CONVERSE
FORMATTED

You cannot use the AID or FROMCURSOR keywords with the
POOL keyword.
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Table 2. Errors that do not cause the syntax checker to issue a message (continued)

Command Error

FEPI INQUIRE
CONNECTION

You cannot use the other keywords apart from NODE or
TARGET if you use the START or END keywords to start or
finish browsing all FEPI connections

FORMATTIME You cannot use the TIMESEP keyword without specifying the
TIME keyword.

GET CONTAINER You cannot use the INTOCCSID, INTOCODEPAGE,
CONVERTST, CCSID keyword with the ACTIVITY,
ACQACTIVITY, PROCESS, or ACQPROCESS keywords.

INQUIRE
ASSOCIATION LIST

You cannot use any INQUIRE ASSOCATION LIST options with
any of the INQUIRE ASSOCIATION options.

You must specify the LISTSIZE keyword.

INQUIRE
CORBASERVER

If you specify the NUMCIPHERS keyword you must also
specify the CIPHERS keyword.

INQUIRE MODENAME If you use the NEXT keyword, you must also use the
CONNECTION keyword.

INQUIRE MONITOR You must specify all of FREQUENCYHRS, FREQUENCYMIN
and FREQUENCYSEC if you use any of them.

You cannot use the FREQUENCY keyword with the
FREQUENCYHRS, FREQUENCYMIN or FREQUENCYSEC
keywords.

INQUIRE TASK You cannot use any INQUIRE TASK LIST options with any of
the INQUIRE TASK options.

INQUIRE
TCPIPSERVICE

If you specify the NUMCIPHERS keyword you must also
specify the CIPHERS keyword.

INQUIRE URIMAP If you specify the NUMCIPHERS keyword you must also
specify the CIPHERS keyword.

INQUIRE VTAM® You must specify all of PSDINTHRS, PSDINTMIN and
PSDINTSEC if you use any of them.

You cannot use the PSDINT keyword with the PSDINTHRS,
PSDINTMIN or PSDINTSEC keywords.

INVOKE SERVICE You cannot use the SCOPELEN keyword without specifying the
SCOPE keyword.

MOVE CONTAINER You cannot use the CHANNEL keyword with the TOPROCESS
or TOACTIVITY keywords.

You cannot use the TOCHANNEL keyword with the
FROMPROCESS or FROMACTIVITY keywords.
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Table 2. Errors that do not cause the syntax checker to issue a message (continued)

Command Error

PERFORM JVMPOOL If you use the START or INITIALIZE keyword, you must also
use the JVMPROFILE, JVMCOUNT and one of: (EXECKEY,
CICSEXECKEY, USEREXECKEY) keyword.

PUT CONTAINER You cannot use the FROMCCSID or DATATYPE keywords with
the ACTIVITY, ACQACTIVITY, PROCESS, or ACQPROCESS
keywords.

READ You cannot use the KEYLENGTH keyword with the RBA,
XRBA or RRN keywords.

You cannot use the GENERIC or GTEQ keywords with the
RBA, XRBA, DEBREC, or DEBKEY keywords.

You must use the EQUAL keyword if you use the RBA, XRBA,
DEBREC or DEBKEY keywords.

You cannot use the RRN keyword with the GENERIC keyword.

READNEXT You cannot use the KEYLENGTH keyword with the RBA, RRN
or XRBA keywords.

You must use the UPDATE keyword if you use the TOKEN
keywords

READPREV You cannot use the KEYLENGTH keyword with the RBA, RRN
or XRBA keywords.

You must use the UPDATE keyword if you use the TOKEN
keywords

READQ TS If you use the SET keyword, you must also use the LENGTH
keyword.

RECEIVE If you use the SET keyword, you must also use the LENGTH or
FLENGTH keyword.

RESETBR You cannot use the KEYLENGTH keyword with the RBA,
XRBA or RRN keywords.

You cannot use the GENERIC keyword with the RBA, XRBA or
RRN keywords.

You must use the EQUAL keyword if you use the RBA or XRBA
keywords.

You cannot use the RBA or XRBA keywords with the GTEQ
keyword.

RETURN You cannot use any other keywords with the ENDACTIVITY
keyword.

You cannot use the CHANNEL keyword with the COMMAREA
or LENGTH keywords.
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Table 2. Errors that do not cause the syntax checker to issue a message (continued)

Command Error

SEND You cannot use the ATTACHID keyword with the CBUFF,
CNOTCOMPL, CTLCHAR, DEST, ERASE, DEFAULT,
ALTERNATE, LDC, LEAVEKB, LINEADDR, PASSBK,
PSEUDOBIN, or STRFIELD keywords.

You cannot use the CNOTCOMPL keyword with the CONFIRM
or INVITE keywords.

You cannot use the ERASE, DEFAULT or ALTERNATE
keywords with the STRFIELD keyword.

You cannot use the LAST keyword with the PASSBK or CBUFF
keywords.

You cannot use the LDC keyword with the FMH keyword.

Must use WAIT if PASSBK or CBUFF is used.

SEND MAP You cannot use the MAPPINGDEV keyword with the NLEOM,
MSR, FMHPARM, LDC, OUTPARTN, ACTPARTN, ACCUM,
REQID, or NOFLUSH keywords.

SET CONNECTION You cannot use the ACQUIRED keyword with the
OUTSERVICE keyword.

SET JOURNALNAME You cannot use the STATUS, ENABLED, or DISABLED
keywords with the ACTION, FLUSH, or RESET keywords.

SET MONITOR When using some, but not all, of the FREQUENCEYHRS,
FREQUENCEYMIN, FREQUENCEYSEC keywords (which can
be used together or separately) syntax errors may not be
reported.

SET TRANSACTION You cannot use the RUNAWAY keyword with the SYSTEM
keyword.

SIGNAL EVENT You cannot use the FROM keyword with the FROMCHANNEL
keyword.

STARTBR You cannot use the KEYLENGTH keyword with the RBA,
XRBA or RRN keywords.

You cannot use the GENERIC or GTEQ keywords with the
RBA, XRBA, DEBREC, or DEBKEY keywords.

You must use the EQUAL keyword if you use the RBA, XRBA,
DEBREC or DEBKEY keywords.

You cannot use the RRN keyword with the GENERIC keyword.

TRANSFORM
DATATOXML

If you use any of the ELEMNAMELEN, ELEMNSLEN,
TYPENAMELEN and TYPENSLEN keywords you must use the
corresponding ELEMNAME, ELEMNS, TYPENAME and
TYPENS keywords. More than one of this type of error will not
be detected. If more than one of this type of error is present
then any subsequent errors will also not be detected.
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Table 2. Errors that do not cause the syntax checker to issue a message (continued)

Command Error

TRANSFORM
XMLTODATA

If you use any of the ELEMNAMELEN, ELEMNSLEN,
TYPENAMELEN and TYPENSLEN keywords you must use the
corresponding ELEMNAME, ELEMNS, TYPENAME and
TYPENS keywords. More than one of this type of error will not
be detected. If more than one of this type of error is present
then any subsequent errors will also not be detected.

WEB EXTRACT If you use EXTRACT WEB for CICS as an HTTP server you
must not specify the SESSTOKEN keyword.

If you use EXTRACT WEB for CICS as an HTTP client you
must specify the SESSTOKEN keyword.

You cannot use the SESSTOKEN keyword with the
REQUESTTYPE keyword.

If you specify the HOST, HTTPVERSION, PATH,
PORTNUMBER, REALM or QUERYSTRING keywords, you
must specify their corresponding length keywords.

WEB EXTRACT You cannot use the SESSTOKEN keyword with the
REQUESTTYPE keyword.

WEB OPEN If you must specify the HOST keyword, you must specify the
HOSTLENGTH and PORTNUMBER keywords.

If you must specify the CIPHERS keyword, you must specify
the NUMCIPHERS keyword.

If you must specify the HTTPVNUM keyword, you must
specify the HTTPRNUM keyword.

WEB PARSE You must specify the URL keyword.

WEB READ If you use the HTTPHEADER keyword, you must also use the
NAMELENGTH, VALUE and VALUELENGTH keywords.

You can also optionally use the SESSTOKEN keyword. No other
keywords must be used with HTTPHEADER.

WEB RECEIVE You cannot use the SESSTOKEN, MEDIATYPE, STATUSCODE,
STATUSTEXT, STATUSLEN, CLIENTCONV, CLICONVERT, or
NOCLICONVERT keywords with the TYPE, CLNTCODEPAGE,
or HOSTCODEPAGE keywords.

If you use the CLIENTCONV, CLICONVERT, or
NOCLICONVERT keywords, you must also use the
SESSTOKEN keyword.

You cannot use the SESSTOKEN keyword with the
SERVERCONV, SRVCONVERT, or NOSRVCONVERT keywords.
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Table 2. Errors that do not cause the syntax checker to issue a message (continued)

Command Error

WEB SEND You cannot use the SESSTOKEN keyword with the
CLNTCODEPAGE, HOSTCODEPAGE, STATUSCODE,
STATUSTEXT, STATUSLEN, LENGTH, SERVERCONV,
SRVCONVERT, or NOSRVCONVERT keywords.

If you use the CLIENTCONV, CLICONVERT, or
NOCLICONVERT keywords, you must also use the
SESSTOKEN keyword.

WEB STARTBROWSE If you use the HTTPHEADER keyword, you may optionally use
the SESSTOKEN keyword. No other keywords must be used
with HTTPHEADER.

WRITE You cannot use the RBA, XRBA or RRN keywords with the
KEYLENGTH keyword.

WSACONTEXT BUILD You must use at one or more of the ACTION, MESSAGEID,
RELATESURI or ERTYPE keywords.

If you use the RELATESTYPE keyword, you must specify the
RELATESURI keyword.

You must either specify all of the EPRTYPE, EPRFIELD,
EPRFORM and EPRLENGTH keywords, or specify none of
them.

WSACONTEXT GET You must use one of the CONTEXTTYPE, REQCONTEXT or
RESPCONTEXT keywords.

You must use at one or more of the ACTION, MESSAGEID,
RELATESURI or ERTYPE keywords.

You must either specify all of the EPRTYPE, EPRFIELD,
(EPRINTO or EPRSET) and EPRLENGTH keywords, or specify
none of them.

WSAEPR CREATE You must use one of the ADDRESS, METADATA or REFPARMS
keywords.

If you specify METADATALEN you must specify METADATA

XCTL You cannot use the CHANNEL keyword with the COMMAREA
or LENGTH keywords.

COBOL for Windows

Local syntax-checking support, and the level of Enterprise
COBOL for z/OS

The COBOL for Windows compiler that is included in Rational Developer for
System z Version 7.6 supports host COBOL syntax at the level of Enterprise
COBOL for z/OS, Version 3 Release 4. Newer syntax that is supported by
Enterprise COBOL for z/OS, Version 4 Release 1 and Release 2 is not supported in
COBOL for Windows.
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Object-oriented syntax, and Java 5 or Java 6 SDKs
The COBOL for Windows Programming Guide, Version 7.5 states in the section
entitled ″Running OO applications″ that the releases of Java™ that are supported
for running object-oriented COBOL applications are the ″IBM 32-bit SDK for
Windows, Java 2 Technology Edition, Version 1.3.1 or later.″

In Rational Developer for System z Version 7.6, however, COBOL applications that
use object-oriented syntax for Java interoperability are supported with Java SDK
1.4.2 and above.

To run these existing applications using Java 5 or Java 6, customers can do these
steps:
1. Recompile and relink the applications using the current version of COBOL for

Windows.
2. Recompile the generated Java class that is associated with each object-oriented

COBOL class using the javac command from Java 5 or Java 6.

The COBOL for Windows Programming Guide content will be replaced at a future
release to indicate these changes.

Runtime message traceback information
In Rational Developer for System z Version 7.6, COBOL for Windows is enhanced
to provide traceback information for some runtime messages. If traceback
information is available for a given message, additional lines of information appear
after the message text.

To include the source-file name and line number in the traceback information, you
must compile a COBOL program with the -g flag. For example:
cob2 -g FNREM01.CBL

results in the source-file name FNREM01.CBL and a line number 1839 from the source
file appearing in the traceback information for message IWZ036W:
IWZ036W Truncation of high order digit positions occurred in program FNREM01

on line number 1967.
iwzrlib.dll : 0
FNREM01.CBL : 1839
iwzrlib.dll : 0
iwzrwin1.obj : 0
kernel32.dll : 0

Note: The line number in the traceback information (1839) references the relevant
line from the source file (FNREM01.CBL), and the line number specified in the
message text (1967) references the LineID from the source listing (FNREM01.lst).

If you compile a COBOL program without the -g flag, you will see an
executable-file name and zero for the line number. For example:
cob2 FNREM01.CBL

results in the executable-file name FNREM01.exe and a line number 0 appearing in
the traceback information for message IWZ036W:
IWZ036W Truncation of high order digit positions occurred in program FNREM01

on line number 1967.
iwzrlib.dll : 0
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FNREM01.exe : 0
iwzrlib.dll : 0
iwzrwin1.obj : 0
kernel32.dll : 0

Traceback information is directed to stderr.

COBOL for Windows Programming Guide content will be updated at a future release
to indicate these changes.

PL/I Enhanced Editing

Limitation: Syntax checking incorrectly identifies errors
The PL/I enhanced editing functionality consists of real-time syntax checking.
Some legal PL/I syntax is marked as errors, and some illegal PL/I syntax is not
marked as an error.

The following legal PL/I syntax is marked as an error:
v Macros
v Entry constants and entry variables
v Type functions
v Reserved attribute
v Parameter attribute
v limited attribute/option
v Generic attributes
v Factoring of attributes when declaring structures
v isub option with defined attribute
v cdecl, optlink, stdcall attributes of the linkage rule for procedure options
v norescan attribute of activate directive
v tstack attribute of the attach statement
v Implicit variable declarations
v Some legal expressions are marked as errors
v Builtin functions and preprocessor functions

The following illegal PL/I syntax is not marked as an error:
v Condition prefixes for do statements
v Label prefixes for declare, default, when, otherwise, and on statements
v Scaling factors for float or fixed
v Duplicate attributes for declaration statements

The following statements are ignored, so illegal syntax in them is not marked as
errors:
v Process statements
v EXEC SQL statements
v EXEC CICS statements
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Debug Tool for z/OS

Documentation updates for Debug Tool for z/OS Version 10
The Debug Tool for z/OS, Version 10, Reference and Messages contains an updated
list of Debug Tool commands that work with the compiled language debugger.
This list is more recent than the one in the information center. The Debug Tool for
z/OS, Version 10, User’s Guide contains some additional tips on how Debug Tool
for z/OS and the compiled language debugger work together. You can find the
Debug Tool for z/OS, Version 10, books at http://www.ibm.com/software/
awdtools/debugtool/library/.

File Manager Integration

File Manager Integration has renamed some of the views
found within the Formatted Data Editor

File Manager Integration has renamed some of the views found within the
Formatted Data Editor.

The following views are equivalent despite the difference in name:
v Formatted page / Formatted mode
v Character page / Character mode
v Table format / Table mode
v Single format / Single mode
v Hex format / Hex mode

Limitation: File Manager Integration requires File Manager
Server Version 10.1

Problem: File Manager Integration requires File Manager Server Version 10.1. If
you are not using File Manager Server Version 10.1, File Manager Integration does
not work.

Workaround: Use File Manager Server Version 10.1.

Limitation: Certain complex criteria created in the Build
Criteria editor are not supported

Problem: Certain complex criteria created in the Build Criteria editor are not
supported by File Manager. These criteria report an error of “FMNBB310
Unbalanced parenthesis” when leaving the Build Criteria editor.

Workaround: Rearrange the criteria to have AND and OR branches that are less
nested.

Limitation: Data is lost when saving a dataset and the RSE
connection is lost

Problem: If you are editing a dataset in the FMI Formatted Data Editor and the
RSE connection to the host is lost , any changes made to the data set in the edit
session since the last save, are lost.

Workaround: Save your changes frequently.
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Limitation: Creating templates with COBOL copybooks
containing a COPY command with a REPLACING clause

When you create a template from a COBOL copybook, File Manager must compile
the copybook as one step in the process of creating the template. When your
COBOL copybook has a COPY command with a REPLACING clause, you might
see a compile failure when attempting to create the template.

This compile failure is caused by, in most cases, File Manager inserting your
COBOL copybook into a simple COBOL program using a COPY statement. The
COPY command with a REPLACING clause in your copybook becomes nested in
another COPY statement. Nested COPY commands with REPLACING clauses are
illegal in COBOL, and the compile error results. However, when you specify a
range in advanced copybook selection, the selected portion of the copybook is
copied inline into the simple COBOL program, rather than being inserted using a
COPY statement. Therefore, the COPY command with the REPLACING clause
would not be nested and the compile would complete successfully.

To successfully create a template with a COBOL copybook containing a COPY
command with a REPLACING clause:
1. Be sure to place the copybook and nested copybooks into the same PDS.
2. Choose ″Advanced copybook template″ in the Create Template″ wizard.
3. Edit the copybook selection to specify a range (specifying a ″From statement″ of

1 and leaving the ″To statement″ blank selects the entire contents of the
copybook).

MFS Editor

Copybook generation support for MFS files
This feature enables users to generate COBOL copybooks for MFS message files
using a contextual menu option on the MFS file. The copybook generation feature
is available for both local and remote MFS files.

C/C++ Language Support

Enhanced makefile editing support
A new Remote Makefile Editorr has been added to support editing of makefiles.
The Remote Makefile Editor provides syntax highlighting, content assist, and an
outline view to easily create and understand makefiles. You can customize the
Remote Makefile Editor features using the new editor preference page.

The Make with target action has been added to z/OS Unix
subprojects and files

The Make with target action has been added to z/OS Unix subprojects and files.
Using Make with target, you can specify a target when building applications.

Predefined LPEX command support
Use the new preference field in the Target Environments Editor Options
preferences to specify a set of LPEX commands to run when a z/OS UNIX®

C/C++ file is opened within the System z LPEX editor.
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Use the new preference field to specify a set of LPEX commands to run when a
z/OS UNIX C/C++ file is opened within the System z LPEX editor. You can use
commands to customize LPEX as files are opened for editing.

Macro support for assembly language
Assembler MVS™ macro definitions have been added to the System z LPEX editor.
These definitions provide additional information when parsing, generating the
outline view, hovering, or invoking content assist when editing assembly (*.s,
*.asm) files in the editor.

F1 help support for assembly language
New context-sensitive help support has been added to the System z LPEX editor
for assembler instructions when editing assembly (*.s, *.asm) files in the editor.

Advanced COBOL Editor

Advanced COBOL Editor
v Added support for parsing embedded SQL code
v Enhanced content assist to include data items declared in EXEC SQL INCLUDE

statements (for example, SQLCA) and implicitly linked CICS data structures (for
example, DFHEIBLK).

v Added support for parsing embedded CICS code
v Added six IMS categories to the Snippets view
v Enabled open declarations, hover help, and other features for data items

referenced in EXEC SQL and EXEC CICS statements.
v Added support for real-time syntax checking of CICS and SQL code embedded

in COBOL programs
v Enhanced the navigation in the COBOL LPEX Editor to use the F3 key and

hyperlinking
v Enhanced content assist to include information about variable declarations
v Limitation: Refactor operations are not atomic and cannot be undone.
v Limitation: The Open Perform Hierarchy operation will not be in sync if the

source file is modified or closed.
v The grammar used for parsing embedded SQL in COBOL programs is not a

complete DB2 for z/OS grammar. Parsing embedded SQL using this limited
grammar is optional and can be enabled on the preferences page LPEX Editor >
System z LPEX Editor > COBOL Parser > COBOL Annotations and Tools.

Application Delopyment Manager

Application Deployment Manager
v Added functions to create an empty Application Deployment Manager manifest

in Eclipse projects and z/OS projects.
v Enhanced Application Deployment Manager to handle a subset of new functions

supported by CICS Explorer.
v Created a connection type for REST to let you use of both REST and SOAP

protocols CICS Resource Definition server connections.
v Limitation: Filtering resources within CICS Explorer views when connected to a

CICS Resource Definition server is limited to the name of the resource.
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v Limitation: Connections to a CICS Resource Definition server using the Web
services connection type do not support new CICS resource types such as
bundles, XML transforms, and event bindings.

v Limitation: Only regions that host a CICS Resource Definition server (connection
regions) are listed in dialogs that generate code or CICS resources such as EST
and SCA.
Regions connected to those connection regions are not listed in the generation
dialogs. Therefore generated artifacts can be deployed only to the region that
runs the CICS Resource Definition server. CICS resources can be in defined,
installed, and discarded from other regions through the Application Deployment
Manifest Editor by selecting a different target region while editing a manifest.
The New ADM Manifest dialogs available from the File menu and z/OS project
pop-up menu support creating ADM manifests that are on not in the same
region as the CICS Resource Definition server.

v Limitation: To change the password of an existing connection to a CICS
Resource Definition (CRD) server, you may need to alter the user ID to a
nonexistent ID, click the Apply button, change the user ID back, and then click
the Connect button. This action causes the connection dialog to prompt for a
new password.

Limitation: Connections to a CICS Resource Definition server
using the Web services connection type do not support new
CICS resource types

Connections to a CICS Resource Definition server using the Web services
connection type do not support new CICS resource types such as bundles, XML
transforms, and event bindings.

Limitation: Only regions that host a CICS Resource Definition
server are listed in dialogs that generate code or CICS
resources

Only regions that host a CICS Resource Definition server (connection regions) are
listed in dialogs that generate code or CICS resources such as EST and SCA.

Regions connected to those connection regions are not listed in the generation
dialogs. Therefore generated artifacts can be deployed only to the region that runs
the CICS Resource Definition server. CICS resources can be in defined, installed,
and discarded from other regions through the Application Deployment Manifest
Editor by selecting a different target region while editing a manifest. The New
ADM Manifest dialogs available from the File menu and z/OS project pop-up
menu support creating ADM manifests that are not in the same region as the CICS
Resource Definition server.

Limitation: Changing the password of an existing connection
to a CICS Resource Definition (CRD) server

To change the password of an existing connection to a CICS Resource Definition
(CRD) server, you may need to alter the user ID to a nonexistent ID, click the
Apply button, change the user ID back, and then click the Connect button. This
action causes the connection dialog to prompt for a new password.
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Software Configuration Library Manager (SCLM) Developer Toolkit

Limitation: ’SCLM Search’ and ’SCLM member security’ are
not supported for z/OS 1.8

SCLM Search and SCLM member security are not supported in base SCLM for
z/OS 1.8 and are therefore unavailable through SCLM Developer Toolkit for z/OS
1.8.

For SCLM Search support, one of the following levels must be installed on the
host:

Program Number Product Name PTFs or Service Levels Required

5694-A01 z/OS v 1.10 or
higher

5694-A01 z/OS v 1.9 APAR OA27379 - all applicable PTFs

For SCLM member security support, one of the following levels must be installed
on the host:

Program Number Product Name PTFs or Service Levels Required

5694-A01 z/OS v 1.11 APAR OA26997 - all applicable PTFs

5694-A01 z/OS v 1.10 APAR OA26997 - all applicable PTFs

5694-A01 z/OS v 1.9 APAR OA26997 - all applicable PTFs
APAR OA27379 - all applicable PTFs

Host Integration

A version of Perl must be installed to start the IBM Rational
Developer for System z Remote Systems Explorer (RSE)
server.

A version of Perl must be installed to start the Rational Developer for System z
Remote Systems Explorer (RSE) server. The Host Connect emulator requires a
Telnet server. The Telnet server must be installed and running on the server that
you connect to using Host Connect.

UNIX Server

Update: AIX, Linux, and Linux on System z installation
Silent install

If X Windows is not available, you can run a silent install from the directory that
contains the untarred Rational Developer for System z installation files:

./install --launcher.ini ./silent-install.ini

Silent uninstall

For a silent uninstall go to the /opt/IBM/InstallationManager/eclipse directory
and run:
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./IBMIM --launcher.ini silent-install.ini -input <RSE install dir>/uninstall/uninstall.xml

A version of Perl must be installed to start the IBM Rational
Developer for System z Remote Systems Explorer (RSE)
server.

A version of Perl must be installed to start the Rational Developer for System z
Remote Systems Explorer (RSE) server. The Host Connect emulator requires a
Telnet server. The Telnet server must be installed and running on the server that
you connect to using Host Connect.

Linux on System z host prerequisites
Linux on System z

One of the following levels must be installed:

Table 3.

Product Name

Red Hat Linux Enterprise Server 5 (s390x)

Red Hat Linux Enterprise Server 4 (s390x)

SUSE Linux Enterprise Server 10 (s390x)

SUSE Linux Enterprise Server 9 (s390x)

The related product Web site is:

http://www-03.ibm.com/systems/z/os/linux/

SDK for Linux on System z, Java 2 Technology Edition

To use Remote Systems Explorer (RSE) on Linux on System z, one of the following
levels must be installed:

Table 4.

Program
Number Product Name

6207-001 IBM 64 bit Runtime Environment for Linux on System z, Java 2
Technology Edition, Version 6

6205-001 IBM 64 bit Runtime Environment for Linux on System z, Java 2
Technology Edition, Version 5

The related product Web site is:

http://www.ibm.com/developerworks/java/jdk/linux/

Attention: The 64 bit version is supported.

Linux on System z RSE server prompts the user for twice to
log in into the system

Connections to the Linux on System z RSE server prompts the user twice for the
user ID and password to log in to the system, once for the Files subsystem and
then again for the OS Shell.
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Limitation: Run Installation Manager as the root user
Installation Manager on Linux on System z SuSE will not work correctly unless the
root user is running the program.

Help Updates

Screen operation
A screen operation contains information for managing a particular application
screen.

This information can be accumulated during screen operations recording or flow
recording or can be created manually using the screen operations editor.

A screen operation contains three types of information:
v A reference to a screen description:

A screen operation contains a reference to a screen description that describes a
particular application screen (see Screen message, screen description, descriptor in
the Developer for System z information center). During flow recording and in a
few other situations, when the host editor has recognized the screen description
that matches the currently displayed application screen, then the host editor
searches for screen operations that reference the recognized screen description
(see Recognized screen description and Finding screen interactions for the current
application screen in the Developer for System z information center).

v Screen interactions:

A screen interaction is a sequence of actions that are applied to the application
screen described by the referenced screen description. The actions can include
Input actions, an AID key action, Insert actions, and Extract action (see
Recognized screen description and Finding screen interactions for the current
application screen in the Developer for System z information center)
A screen operation can contain multiple screen interactions. When you record a
flow, the host editor provides each new flow node with not only a reference to a
particular screen operation but also with a notation of which screen interaction
in that screen operation is to be performed when the flow node is played back.

Note: Although each screen interaction is assigned a default name when it is
created, such as ″Screen Interaction 1″, you should assign a more meaningful
and memorable name to each screen interaction that you intend to use in a flow
recording. Then, when you are doing the flow recording and the host editor
allows you to select from a list of screen interactions a single screen interaction
that is going to be used to process the current application screen, you can look
at the name of each screen interaction in the list and hopefully remember from
the name what actions the screen interaction performs.

v A list of next screens:

A next screen is the name of a screen description that matches one of the
application screens that can validly occur after the currently displayed
application screen. The list of next screens contains one next screen for each
application screen that can validly occur.
At runtime, after the specified AID key is generated and the next application
screen is displayed, the runtime environment compares each screen in the list of
next screens with the new application screen until a match is found. Only screen
descriptions screens in the current list of valid next screens are compared.
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Implementation of Extract actions and Insert actions
This topic describes how Extract actions and Insert actions are implemented in a
recorded flow.

Recall that an Invoke screen operation node specifies the information required to
manage the transition from one application screen to the next. The input actions
(Input actions, AID key actions, and Insert actions apply to the currently displayed
application screen. The output actions (Extract actions) apply to the next
application screen displayed. (See Screen operation in the Developer for System z
information center.)

When an Invoke screen operation node is performed the runtime environment
processes the information in the associated screen operation in the following order:
1. It performs the input actions on the currently displayed screen:

a. It performs the Insert actions (if any).
b. It performs the Input actions (if any).
c. It performs the AID key.

2. It waits for the host to send the next application screen.
3. It does screen recognition by comparing each screen in the next screen list to

the next application screen until it finds a match.
4. It selects the output terminal associated with the recognized screen description.
5. It performs the output actions on the newly displayed application screen:

a. It performs the Extract actions (if any).

The flow of control then passes to the next node in the flow.

The input actions (Input actions, AID key action, and Insert action) are
implemented as mappings in the mapping routine associated with the input
terminal of the Invoke screen operation node (see How actions are implemented in
mappings: AID key, Input, Extract, and Insert in the Developer for System z
information center).

The output actions (Extract actions) are implemented as mappings in the mapping
routine associated with selected output terminal (see How actions are implemented in
mappings: AID key, Input, Extract, and Insert in the Developer for System z
information center).

Web Delivery Help (Remote Help)

Web-based help content
The Developer for System z help system is configured to use remote help so that
you can pull in content from the Web dynamically. With remote help, you always
have the latest content available from within Developer for System z. Some help
systems are not configured to access help content on the Web; in such cases, help
content is included with the installation.

You can obtain help three ways. One of these options is best for you, depending on
your needs and situation:
v The help content can be accessed on the Web so that you can have the smallest

installation footprint and the most up-to-date information.
v The help content can be downloaded and accessed on your computer so that

you can work disconnected from the Internet with periodic updates.
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v The help content can be deployed on an intranet server so that you can work
behind a firewall with administrative updates.

You can change your access decision at any time. If you install multiple products
together, you can use different locations for the help for each product, depending
on installation footprint, frequency of use, and internet policies. If internet speed is
an issue, a longer one-time download and local access might be preferable. Later
help updates include only differences.

If you are an administrator and you want users to access help content from an
intranet server, see the Installation Manager information center for instructions on
how to install the help WAR file on a server. In the Installation Manager
information center, select Enterprise installation articles -> Delivering help
content from an intranet server.

Accessing Web-based help
Help for Developer for System z is available on a product information center on
the Internet. You can view this help from within Developer for System z.

Before you begin

During installation, the option to access help from a remote information center was
selected. This option is the default selection.

About this task

The Developer for System z help system can retrieve content installed with the
product, as well as content from a remote server running an information center.
The information center for Developer for System z has the most current help
content and when Developer for System z is configured to retrieve content from a
remote information center, the contents of the information center can be accessed
by selecting Help → Help Contents to open your help system.

During installation, Developer for System z was configured to access the help from
the product information center.

The information center for Developer for System z is available from the following
Web address:

http://publib.boulder.ibm.com/infocenter/ratdevz/v7r6/index.jsp.

Follow these steps to check your connection to the information center:
1. Open the Preferences dialog
2. Select Help → Content

3. Ensure that Include help content from a remote infocenter is selected.
4. Ensure that the URL for the Developer for System z information center is in the

list of available information centers. If your information center is not listed,
complete the following steps:
a. Click Add

b. In the Name field, enter a name for the connection.
c. In the Host field, enter publib.boulder.ibm.com
d. In the Path field, enter /infocenter/ratdevz/v7r6
e. Select Use default port

f. Click OK
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5. Select the entry for the Developer for System z information center.
6. Click Test Connection.

Downloading help content with the Local Help System Updater
site
This topic explains how to download, remove, and update help content from the
Local Help System Updater site. Most help content is not installed when you
install Developer for System z with web delivery enabled. To access all help
content locally, you need to download it from the IBM Local Help System Updater
Web site.

Before you begin

During installation, the help access option, Download help and access the content
locally, was selected.

About this task

Before using the help for the product, you have to download the help to your local
system.

To download the help content from the Local Help System Updater site, complete
the following steps:
1. With Developer for System z open, click Help → Local Help Updater. The

Updater site opens.
2. In the x pane, select the location of the help you want to download. For IBM

Rational Developer for System z, select Developer for System z. If Developer
for System z is not in the list, you need to add the location.
a. Select the Internal Sites tab.
b. Select the + icon to add a location.
c. Select Remote.
d. Type a name for the site.
e. Type http://publib.boulder.ibm.com/infocenter/ratdevz/v7r6/site/site.xml

for the URL.
3. The Available Features list is populated with a list of the help that is available

for download. Depending on your network connection speed, this operation
might take a few minutes. Select the help content that you need.

4. Click Install. The help content is downloaded and installed. A progress bar
opens and tracks the status of the download.

5. When the download is completed, open the help in the product by selecting
Help → Help Contents.

Results

The help that you selected is installed on your system. The files are updated
automatically when an Internet connection is available.

Installing help content locally using the Local Help Updater and
the RDz7.6_updateSite.zip file
If you are not going to use remote help to access the help content from the Web,
you must install the help content locally. This topic explains how to install the help
content using the Local Help System Updater and the RDz7.6_updateSite.zip file
provided in the install image.
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Before you begin

During installation, the help access option, Download help and access the content
locally, was selected.

About this task

Before using the help for the product, you have to install the help to your local
system.

To install the help content on the workstation using the Local Help System
Updater, complete the following steps:
1. Extract the contents of the file RDz7.6_updateSite.zip to a temporary location

on your system. This file is available on the Developer for System z
documentation CD. Remember this location.

2. Open Developer for System z, click Help → Local Help Updater. The Local
Help Updater opens.

3. Specify the location of the extracted RDz7.6_updateSite.zip file.
a. Select the Internal Sites tab.
b. Select the + icon to add a location.
c. Select Local.
d. Type a name for the site.
e. Click Browse and browse to the location where you extracted the contents

of RDz7.6_updateSite.zip.
f. Click OK. A progress bar opens and tracks the status as the Local Help

Updater searches for the available features included in the
RDz7.6_updateSite.zip file.

4. The Available Features list is populated with a list of the help that is available
for download. select IBM Rational Developer for System z Documentation.

5. Click Install. A progress bar opens and tracks the status of the install.
6. When the installation is complete, open the help in the product by selecting

Help → Help Contents.

Results

The help that you selected is installed on your system.

Updating help content
Use the Local Help System updater to ensure that you have the latest help content.

Before you begin

You have installed help features from the Local Help System Updater Web site.

About this task

Updates are automatically installed each time you start the product, if you have an
Internet connection.

To update the help without restarting the product, complete the following steps:
1. Close the product help system window.
2. Open the Local Help System Updater by selecting Help → Local Help Updater.

The Updater site opens.
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3. Click the Installed Features tab.
4. Click Search for Updates. If updates to the content you have installed are

available, they are installed to your system. A progress bar indicates the status
of the request.

5. When the update is completed, open the help in the product by selecting Help
→ Help Contents.

Removing help content
You can use the Local Help System Updater to remove installed help content.

Before you begin

You have downloaded help features using the Local Help System Updater.

About this task

To remove installed help content, complete the following steps:
1. Close the product help system window.
2. Open the Local Help System Updater by clicking Help → Local Help Updater.

The Updater site opens.
3. Click the Installed Features tab.
4. Select the features that you want to remove, then click Remove. The help

features you selected are removed from your system. A progress bar indicates
the status of the request.

5. When the removal is completed, open the help in the product by selecting Help
→ Help Contents.

Setting up an intranet server for help content
You can set up an intranet server behind a firewall to provide help content to
users. With this method, users do not have to download and save help content to
their computers.

Before you begin

You have a server available that can be accessed by users behind a firewall.

About this task

See the Installation Manager information center for the instructions for setting up
an intranet server for help content. In the Installation Manager information center,
select Enterprise installation articles -> Delivering help content from an intranet
server.

Changing the way that you access help content
You can change the way that you access help content. You can choose from the
following methods: access help from the Web; download help and access content
locally; or access help from a server on your intranet.

Close the help browser before you change the way that you access help content.

During the installation process, you selected one of the following methods for
accessing help content:
v Access help from the Web.
v Download help and access content locally.
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v Access help from a server on your intranet.

To change the way that you access help content, complete the following steps:
1. Click Windows → Preferences. The Preferences window opens.
2. Expand the Help entry, and then click Content. A list displaying the currently

configured information center or centers opens. Depending on the access
method that was chosen, complete one of the following procedures.
v To change from accessing help content from an information center on an IBM

Web site to accessing help content on an intranet server, follow these steps:
a. Disable the link to the internet site by selecting the Web address in the

Contents list, and then clicking Disable.
b. Click Add; then name the intranet connection, specify the intranet Web

address for the server that contains the help content, and then click OK.
c. Click OK to close Preferences.
d. Click Help → Help Contents, to open your help.

v To change from accessing help content from an information center on an IBM
Web site to downloading and accessing help content locally, follow these
steps:
a. Ensure that Include help content from a remote information center is

selected.
b. Disable the link to the product Information Center by selecting that

connection in the Contents list, and then clicking Disable.
c. Click Add; then enter a name for the local help connection. Specify the

localhost Host IP address 127.0.0.1 and path /help. Select any unused
port number, and then click OK.

d. Save any work and close and restart the product.
e. Follow the instructions in “Downloading help content with the Local

Help System Updater site” on page 34 to download help content.
v To change from accessing help content locally to accessing help content from

an IBM Web site, follow these steps:
a. Ensure that Include help content from a remote information center is

selected.
b. Disable the link to localhost by selecting that connection in the Contents

list, and then clicking Disable.
c. Click Add; then name the connection, specify the Web address for the

IBM Web site that contains the help content, and then click OK. This Web
address might already be available in the list of connections. If it is listed,
select the connection and click Enable.

d. Click OK to close Preferences.
e. Click Help → Help Contents, to open your help.

v To change from accessing help content locally to accessing help content from
an intranet server, follow these steps:
a. Ensure that Include help content from a remote information center is

selected.
b. Disable the link to localhost by selecting that connection in the Contents

list, and then clicking Disable.
c. Click Add; then name the connection, specify the intranet Web address

for the server that contains the help content, and then click OK.
d. Click OK to close Preferences.
e. Click Help → Help Contents, to open your help.
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v To change from accessing help content from an intranet server to
downloading and accessing help content locally, follow these steps:
a. Ensure that Include help content from a remote information center is

selected.
b. Disable the link to the intranet server by selecting that connection in the

Contents list, and then clicking Disable.
c. Click Add; then enter a name for the local help connection. Specify the

localhost Host address 127.0.0.1 and path /help. Enter any unused port
number, and then click OK.

d. Save any work and close and restart the product.
e. Follow the instructions in “Downloading help content with the Local

Help System Updater site” on page 34 to download help content.
v To change from accessing help content from an intranet server to accessing

help from an IBM Web site, follow these steps:
a. Disable the link to your intranet site by selecting the intranet Web

address in the Contents list, and then clicking Disable.
b. Click Add; then name the connection, specify the Web address for the

IBM Web site that contains the help content, and then click OK.
c. Click OK to close Preferences.
d. Click Help → Help Contents, to open your help.

Enterprise Service Tools

Single-service projects

XML TRANSFORM resources in the CICS TS 4.1 runtime
Enterprise Service Tools Single service projects integrate the new XML Assistant
feature of the CICS Transaction Server V4.1

A new set of projects, wizards, and batch processor options provides the ability to
generate artifacts that enable XMLTRANSFORM resources in CICS TS 4.1 runtime.
For COBOL and PL/I interpretive scenarios, the functionality is the same as with
the CICS XML Assistants tool that was introduced in the CICS TS V4.1. For
compiled (Vendor) conversion in a bottom-up scenario, this new feature generates
the appropriate COBOL converters. The resources generated by this feature can
then be used in the new CICS EXEC TRANSFORM XMLTODATA and
DATATOXML.

Generating PL/I language data structures and runtime-specific
XML message processing
Support has been added to allow you to generate PL/I language structures and
runtime-specific XML message processing from a Web service description.

Note: This feature is supported only for Web Services for CICS.

The user can start with a WSDL document that defines an existing Web service,
They can create an application from it that implements some or all the
functionality described in the Web service definition. To assist the user in writing
the new PL/I application, the tool generates a template PL/I program coded for
either a new Web service provider or a new Web service consumer. This new
program uses language structures that correspond to the message elements for
each operation (operation -> input -> message -> part -> element), where the
element is an XML Schema type) to process requests and issue replies.
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Generating WSBind with the new WSBind parameters introduced
in CICS TS 4.1
Enterprise Service Tools Single service projects provide support for the new CICS
Web Services WSBind parameters (REQUEST-CHANNEL, RESPONSE-CHANNEL,
DATETIME & DATA-TRUNCATION) in CICS TS 4.1.

This feature adds a graphical user interface and batch processor options that
allows users to generate WSBind with the new WSBind parameters introduced in
CICS TS 4.1. In previous versions, it was possible to create a Web service provider
from a language structure with one container only, typically DFHWS-DATA. CICS
Transaction Server V 4.1 introduced the capability to create a Web service provider
from an application that uses many containers on a channel. Also, it added support
on how the XML elements of the xsd:dateTime type are mapped into the CICS
ASKTIME format and how truncated data is treated by the CICS native conversion
mechanism.

Mapping XML attributes to language structure members
Enterprise Service Tools Single service projects provide Support for mapping XML
attributes to COBOL language structure members and generating corresponding
COBOL Compiled XML Conversion artifacts.

The Enterprise Service Tools Single-service Projects Mapping Editor and COBOL
XML converter code generators now support the mapping of XML attributes to
language structure members. Using this support, it is now possible to parse and
generate XML documents that contain both XML elements and XML attributes. The
ability to convert XML attributes is important because of the common practice for
XML Schema authors to define XML documents that employ a mixture of XML
elements and XML attributes to hold instance data. To indicate that both XML
elements and XML attributes are supported, the Mapping Editor now decorates
elements and attributes with appropriate icons.

Creating MTOM/XOP-based Web service providers
Enterprise Service Tools Single service projects provide support for creating
MTOM/XOP-based Web service providers from both CICS commarea and
channel-based applications.

MTOM (Message Transformation Optimization Mechanism) is an abstract
specification that describes, among other things, a technique to optimize SOAP
messages where binary objects are used to carry data instead of the typical XML
payload. XOP (XML-binary Optimization Package) describes how those binary
objects, which were attached using MTOM, can be represented in binary octets
instead of base64. Using MTOM/XOP, a Web service requester and provider can
exchange request and response language structures in binary format without
having to use an intermediate XML representation. While SOAP messages are still
used in this configuration, the body of the messages are brief, essentially
containing a single XML element that references a binary attachment. To enable a
CICS application as an MTOM/XOP Web service, specify the scenario ″Create New
MTOM/XOP Service Interface″ when creating Web services for CICS Single service
projects.

XML and Web Services batch processor: Specifying directory for
input language file location
The location of the COBOL input files can be specified in the importDirectory
attribute as an absolute path, starting with the drive specification (for example,
C:\mypath\test).
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If, instead, a relative path is desired (for example, so that the configuration files
and Cobol source code can be relocated without changing any file locations in the
xsebatch configuration files), try doing the following:

Table 5.

Directory: Description:

C:\workspace\account_details Main project

C:\workspace\account_details\cobol_src Subdirectory with COBOL source files to
import

C:\workspace\account_details\
xsebatch_config

Subdirectory with XML configuration files
for xsebatch

Then you could use the following InputOutputMessage element for a COBOL
source file called DFH0ACTD.cbl in the cobol_src directory:
&ltInputOutputMessage importFile="../cobol_src/DFH0ACTD.cbl"&gt;</InputOutputMessage>

Alternatively, you may place the COBOL source files in the same directory from
which xsebatch is invoked

XML and Web Services batch processor: Specifying data names
in mixed case
Even though the COBOL data names are not case sensitive, you need to specify the
exact case in the specification xml files. For example, if in the COBOL data source,
the data name is called MY-Data, in the Service specification xml the
nativeTypeName attribute must be set to nativeTypeid=″MY-Data″. If you don’t
specify the exact case, the data name will not be found and the first available level
01 data name will be used by default.

Compiled XML Conversion issues the message IRZ9999S
Problem: Enterprise Service Tools Compiled XML Conversion issues the message
″IRZ9999S Failed to retrieve the text of a Language Environment® runtime
message. Check that the Language Environment runtime message module for
facility IRZ is installed in DFHRPL or STEPLIB.″

Workaround: Compiled XML Conversion now requires access to runtime data set
SFEKLOAD that contains the messages for the Language Environment facility id
″IRZ″. This data set is available on the IBM Rational Developer for System z
installation media. For convenience, install the SFEKLOAD data set into linklist.

Limitation: 01 level scalar element is not supported
In the Enterprise Service Tools Single service projects that enable PL/I application
as Web services, the 01 level scalar element (Example: DCL 01 CHARARRAY
char(255);) is not supported. Only composed types are supported.

Limitation: PL/I Compiled XML Conversion does not honor the
optional ″aligned″ or ″unaligned″ attributes
Problem: Enterprise Service Tools PL/I Compiled XML conversion does not honor
the optional ″aligned″ or ″unaligned″ attributes on PL/I language structures or
language structure members.

Workaround: None; This condition is a limitation of PL/I Compiled XML
Conversion.

40 Rational Developer for System z 7.6 release notes



Limitation: Meet-In-Middle import source files
Problem: In the meet-in-middle development scenario, in the Import source files
wizard, importing with the File System option is not supported.

Workaround: Copy all the required files into a general project and then import
them by selecting Workspace in Import source files wizard.

Limitation: Bottom-Up conflict with old WSDL/XSD files and new
WSDL files and XSD files
Problem: In the bottom-up development scenario, using an older version of
generated WSDL files and XSD files with newly generated converters can cause
errors at runtime. For example, the following runtime error message can occur:
IGZ0282S XML to data structure conversion could not complete in program PGMNAME because no element names in the XML document were recognized by the c

Solution: WSDL/XSDs generated with a converter should always be coupled with
the converters.

Limitation: COBOL conversion routines generated by
single-service wizards run in z/OS only
Even though the workstation COBOL compiler supports XML PARSE statements at
both compile time and runtime, the COBOL programs generated by the
single-service wizards are designed to run in the z/OS environment only

Limitation: The Top-down and Meet-in-middle scenarios with
importing remote (z/OS UNIX) WSDL file which includes, imports,
or redefines a schema is not supported
Problem: In an Enterprise Service Tools project, if you are running Create New
Service Implementation (top-down) scenario or Map to an Existing Service
Interface (meet-in-middle) scenario, with the WSDL file (that was originally
imported from a remote location) that includes, imports, or redefines a schema, it
would fail with an error.

Workaround: Copy all the required files to the workstation or to a general project
in the workspace and import the local WSDL file into the ″Web Services for CICS
Project″ using RMB>Import>Source files and try the top-down scenario.

Limitation: XML Element nesting depth
Problem: The XML to language structure converter returns the following exception
message:
IGZ0291S XML to data structure conversion could not complete
in program program-name because the maximum XML element
nesting depth was exceeded. The error occurred at element
element-name with character content character-content.

Workaround: The XML to language structure converter could not handle the
nesting depth of a particular XML element. Though there is an allowance for
nesting levels beyond that of the original COBOL structure, it can be exceeded. If
an element exists in the request XML document that is not in the schema, the
element will cause this condition if its nesting level is too deep.

Limitation: OPT compiler option conflict
Problem: The OPT compiler option in the generated PROCESS statement in driver
and converter programs will conflict with the TEST option if you specify it as a
compile option in your JCL.
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Workaround: If you want to debug the generated XML converter programs,
deselect the ″Optimization″ check box in the ″Specify compiler-related preferences″
group on the ″Generation options″ page in the Web service wizard.

Limitation: Case sensitivity of certain text entry fields in XML
Enablement wizards
Problem: Folder and file name entries are case sensitive in Eclipse on Windows.

Workaround: Make sure that you enter folder and file names consistently. For
example, if your folder name shows as MyFolder in the Workbench, you must type
MyFolder in an entry field requesting a folder name. If you enter myfolder, for
example, the tools may flag this as an invalid or nonexistent folder name.

Limitation: Invalid pointers cause infinite loop
Problem: Providing non-null invalid pointers to XML converters or drivers causes
an infinite loop.

Workaround: The XML converters attempt to detect and report null pointers
passed by the caller. For non-null invalid pointers, the XML Converters will likely
encounter and return, a protection exception (SOC4).

Limitation: FILLER items in COBOL data structures
Problem: Unnamed groups and their elementary items are not available for
selection on the data structure selection page or the mapping session editor
because the parent item is filtered out along with its elementary items.

Workaround: Edit the COBOL data structure and give names to the groups and/or
elementary data items that require conversion. Giving a name to the COBOL group
makes its non-filler elementary items available for selection.

Limitation: Automatic Match Mapping of COBOL groups
containing OCCURS DEPENDING ON items
Problem: If a COBOL data item is, or contains, an ODO item, you cannot perform
a ″Match mapping″ action with a compatible XML structure unless you manually
map the ODO object before attempting the Match mapping action.

Workaround: Prior to attempting the Match mapping action, manually map the
ODO object according to the mapping rules. (In the XML document, the element
mapped to the COBOL ODO object item must appear before the XML element that
is mapped to the corresponding COBOL ODO subject.)

Limitation: Generate>XML File menu item does not honor XSD
schema restrictions
Problem: The Generate -> XML File menu item does not honor restrictions in an
XSD schema. Using the Generate XML File action on an XSD created by Enterprise
Service Tools could lead to the generation of invalid XML files.

Workaround: Edit the generated XML file so that the tag contents conform to the
restrictions specified in the XSD schema.

Limitation: XML and Web Services batch processor: Invalid
entries in configuration XML may cause null pointer exceptions
during the batch process
Problem: Invalid entries in the options XML files (Container.xml,
PlatformProperties.xml, ServicesSpecification.xml) may cause null pointer
exceptions during the execution of the batch processor.
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Workaround: Follow the format for correctly specifying entries in the options XML
files.

Limitation: Restriction on figurative constants LOW-VALUES and
HIGH-VALUES
Figurative constants LOW-VALUE(S) and HIGH-VALUE(S) can be present in
COBOL data structures used in the single-service wizards, but their semantic
meaning is ignored by the single-service wizards and is not carried into the
artifacts generated by these Enterprise Service Tools single-service wizards

Limitation: GB18030 characters in an Enterprise Service Tools
single-service project name
Problem: Using characters from the GB18030 code page in an Enterprise Service
Tools single-service project name causes errors to occur when you run an
Enterprise Service Tools single-service wizard on files in the project.

Workaround: Do not use GB18030 characters when naming an Enterprise Service
Tools single-service project.

Limitation: Temporary files not always cleaned up
Problem: After running an Enterprise Service Tools single-service wizard, you may
sometimes notice that temporary files (for example, ~DF45B.tmp) are left in the
Enterprise Service Tools single-service project folder.

Workaround: If you see similarly named files in your Enterprise Service Tools
single-service project after running an Enterprise Service Tools single-service
wizard, you can safely delete such files

Limitation: Temporary project not always cleaned up
Problem: The migration process for the old mapping files requires that the
referenced mapped source files be in the same folder as the mapping file. If this
requirement is not met, the Mapping migration tool will fail with the following
error message: ″Resource [filename].mapping is not local″.

Workaround: If you see similarly named projects in your workspace after running
an Enterprise Service Tools single-service wizard, you can safely delete those
projects.

Limitation: When migrating version 6.0 mapping files (.cmx files)
source files referenced by the .cmx file must be in the same
folder
Problem: The migration process for the old mapping files requires that the
referenced mapped source files be in the same folder as the mapping file. If this
requirement is not met, the Mapping migration tool will fail with the following
error message: ″Resource [filename].mapping is not local″.

Workaround: Move the referenced source files into the same folder as the mapping
file that is being migrated.

Limitation: Support for DBCS data members with SOAP for CICS
and Web Services for CICS
Support for DBCS data items in Enterprise Service Tools single-service projects
requires that the request and response XML documents are encoded in UTF-16 or
UTF-8. If the target runtime of the Web service is SOAP for CICS, configure the
feature to exchange XML in UTF-8 or UTF-16 with the XML Converter Driver. The
Web Services for CICS runtime will exchange XML in UTF-8 with a client by
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default while the XML Converter Driver exchanges XML with CICS in UTF-16;
when UNICODE is needed, UTF-16 is the most efficient choice currently for the
XML Converters. For either runtime, it might be necessary to configure z/OS
support for UNICODE with a conversion image that supports conversion between
UNICODE and the DBCS host codepage.

Limitation: DBCS characters are not allowed in the name of the
generated XML converter files
Problem: DBCS characters are not allowed in the names of Partitioned Data Set
members on z/OS.

Workaround: Omit DBCS characters when specifying the name of the XML
converter files. Also, check that the default file names suggested by the Wizard do
not contain DBCS characters.

Limitation: Global element names in generated XML schemas are
not consistent between Interpretive and Compiled XML
conversion types
Problem: The web service message root element names in the XML schemas
generated by default generation of Interpretive and Compiled XML conversion do
not match. You may need to change the generation default of the Compiled XML
conversion to match the Interpretive conversion case as described below in the
Workaround section. This will let you change the conversion type from interpretive
to compiled if needed later without having to republish the WSDL file and without
changing code in clients of the web service.

Workaround: When generating the artifacts for Compiled XML conversion you can
use the wizard to change the root element name to match the Interpretive XML
conversion. This new option called ″Root element name″ is located in the
Generation Options page, on the WSDL and XSD options tab, in the request and
response XML Schema properties group.

For example, the COBOL group named A-B-C will cause the Interpretive
conversion artifacts to have the message root element name ″a_b_c″. The default
Compiled conversion artifacts will have the root element name ″ABC″. As
described earlier you can change ″ABC″ in the wizard to ″a_b_c″ to match with the
WSDL generated for the interpretive conversion.

Limitation: Enterprise COBOL issues message IGYOP3094
when compiling COBOL XML Converters using the OPTIMIZE
(OPT) option.

Problem: The Enterprise COBOL optimizer flags several PERFORM statements in
the Compiled XML Conversion code generated by RD/z Enterprise Service Tools
Wizards when using the COBOL optimizer. The format message of the message is
“IGYOP3094-W There may be a loop from the ″PERFORM″ statement at
″PERFORM (line n)″ to itself. ″PERFORM″ statement optimization was not
attempted.”

Workaround: The control flow of the XML2LS converter is too complex for the
COBOL optimizer to process. The algorithm used by the COBOL optimizer is
currently unable to recognize that a GO TO statement in the XML2LS converter
that leads to a previous point in the program is not unconditional; therefore, in this
case, the message IGYOP3094 represents an optimizer limitation, not a problem
with the correctness of the generated code. For additional information, see
Enterprise COBOL APAR PQ74496.
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Service flow projects

Expanded runtime support for CICS Transaction Server for z/OS
v CICS Service Flow Runtime: Level 2.0 supports CICS Transaction Server for

z/OS V4.1, V3.2, and V3.1 with APAR PK83534.
v CICS Service Flow Runtime: Level 1.0 supports CICS Transaction Server for

z/OS V3.1 without APAR PK83534.

Improvements for Extract actions, Insert Actions, and loop
variables
v Extract actions can store separate data for each iteration of a loop.
v Selection of variables for Extract actions, Insert actions, and loop variables:

– The Select Variable window filters out variables that are inappropriate for the
current action, displays the characteristics of eligible variables, and does not
allow the user to select a variable having the wrong characteristics.

Limitation: A Web service generated from a service flow project
cannot call itself (recursive call)
A Web service generated from a service flow project cannot call itself, either
directly or indirectly. In general, the service flow project tools do not allow you to
create a recursive invocation of a flow, that is, a flow invoking itself, either directly
or through intermediate calls.

However, the service flow project tools currently do not detect the following type
of recursion:
v You generate a Web service (for example, WS01) from a service flow project.
v The generated Web service (WS01) invokes some other Web service (for example,

WS02). (By the way, in the Enterprise Service Tools, WS02 is termed an
″outbound Web service″, because it is external to the Web service that invokes
it.)

v The invoked Web service (WS02) in turn invokes the original Web service
(WS01).

In this situation: The flow editor does not detect the recursion when you create it
and does not display an error message. You can successfully generate runtime code
for the CICS Service Flow Runtime and deploy the Web service (WS01). When you
run the Web service (WS01), the invocation to the second Web service (WS02) is
successful. However, the recursive invocation (from WS02 back to WS01) fails.

Limitation: A limitation on a flow with a connection wired back
onto itself
Problem: The flow editor does not prevent you from adding connections that wire
the execution path of a flow back onto itself (at an earlier point in the flow’s
execution path). This situation may not cause errors when you generate runtime
code. However it is very likely to lead to errors during runtime processing.

Workaround: When you want part of a flow to be iterated multiple times so long
as a certain condition is true, use a While node (see the topic ″Creating a loop″ in
the Enterprise Service Tools documentation).

Limitation: Importing a COBOL copy book file fails when the
path or file name contains non-English characters
Problem: If you attempt to import a COBOL copy book file, and the file path or
the file name contains non-English characters, then the import fails.
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Workaround: Rename the PL/I include file so that the name contains only English
characters. Locate the file in a directory whose path contains only English
characters.

Limitation: Conflicting message and field names cause compile
error
Problem: When you model a flow, and a field of one message has the same name
as another message, the generated COBOL code may not compile, reporting a
IGYPS0037 error, due to the naming conflict. For example, if the flow references (1)
a message called ’X’ with a field called ’Y’ and (2) a message called ’Y’, when the
generated code refers to item ’Y’ the COBOL compiler will not know whether the
reference is to the message ’Y’ or the field ’Y OF X’.

Workaround: Refactor either the message or the field to resolve the name conflict.
In the EST Project Explorer, select one of the items with the duplicate names. Open
the context menu and choose Rename.

Limitation: A limitation on imported source code with a usage
clause of POINTER
Problem: Importing COBOL or PL/I source code data structures containing fields
with a usage type of POINTER will create a message with a corresponding field of
type hexBinary. This will cause the Generate Runtime Code wizard to fail.

Workaround: Edit the message in the Message Editor. On the Advanced tab of the
editor, change the field’s type from hexBinary to int. This change enables the
generation to complete successfully.

Limitation: Screen messages are not easily replaced
Problem: If you accidentally delete screen message files and attempt to re-import
or re-capture screens to replace them, references to the messages in those files may
remain broken. This is because for each screen message, a unique identifier is
generated, and this unique identifier is used to identify the screen messages in
other files.

Workaround: Back up your projects often. If you accidentally delete screen
message files and do not wish to re-model your flows, bring screen messages back
by importing the backed up versions of the files rather than re-importing or
re-capturing your screens.

Limitation: Importing a COBOL program for use as a LINK with
Channel node and opening the operation in the operations editor
prevents modifying the generation properties
Problem: After importing a COBOL program for use as a LINK with Channel
node, and opening the operation in the operations editor, you cannot modify the
generation properties to select Service Flow runtime: level 1.0 is not listed as a
choice for selection.

Workaround: Change the program type to commarea or MQ, press OK, save your
changes, then reopen the generation properties editor. Then the choice for runtime
level 1.0 is available.

Limitation: Flow plays back incorrectly if it contains a while loop
that exits from a node other than the last node
Problem: When recording a while loop, you can choose multiple flow nodes as
potential exit nodes. Flow playback assumes that the last node of the inner flow of
the loop is always the exit node for the loop. This assumption can cause the flow
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playback to result in a ″Macro timed out″ error if your loop exits from a node
other than the last node. This limitation does not affect generation for the service
flow runtime.

Workaround: Exit while loops from the last node in the loop.
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